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System Requirements

ProTracker Cloud users need only a high-speed Internet connection and a Java-enabled browser
running on the platform of their choice. Cloud users may want access to the Recommended
Hardware Accessories listed below.

Server Requirements (SQL only)

The server will store the Microsoft SQL Server Express software and the ProTracker Advantage
database files.

Windows 2000 SP4, Windows XP, Windows Server 2003 SP2, Windows Vista (32-bit versions)
1 GHz CPU

1 GB RAM

700 Mb disk space

Workstation Requirements (Access and SQL)

Each workstation will store the Advantage application software and the runtime version of Access
required to run the application.

Windows 2000 SP4, Windows XP, Windows Vista (32-bit versions)

1 GHz CPU

1 GB RAM

250 Mb disk space

Microsoft Office 2002 or later for mail merges and exporting to spreadsheets.
Microsoft Outlook 2002 or later for email archiving and PDA synchronization.

Recommended Hardware Accessories (All Versions)

Document Scanner (TWAIN compliant)

Printer with Envelope Feeder

Single Label Printer (Dymo LabelWriter recommended).
Business Card Scanner (Corex CardScan recommended)
PDAs that synchronize with Microsoft Outlook

Software that is NOT required:

Microsoft Access™ (Access 2003 runtime is included)
Microsoft Outlook Exchange Server™

Document Management

Adobe Acrobat

ProTracker Advantage runs only on PCs, not MACs. The screens and documentation are written in
English only and currency calculations and displays are in US dollars and cents. Some calculations
and reports are based on US laws and regulations.

-3-

ProTracker Advantage Getting Started Guide Microsoft SQL Version



Initial Administrative

Setup

Before you begin to use ProTracker Advantage, perform the start-up steps in this section of the

guide.

Adding Users

If the current user has not been added to the Advantage database, the Add a User dialog will
appear. The person who will use Advantage from this computer should be added. Other employees
should be added from the computer where they will normally access Advantage. Additional users
may be added at any time by clicking the Operations menu and selecting Users.

Select an Emploves |

||

or Enter a new Emploves |

Windows Login Mame* |.ﬁ.ssistant|

This account is walid For % Ay Computer

Select a Role for this user

% Administrator &
IUser has unrestricted access to the
application,

& Power User &

IUser has unrestricted access to the
application but may nok add/edit
users or change Database
Administration options,

Save Sawve and Add Another

™ This computer OMLY

Standard User

IUser has access to most areas of the
application, but may nok access the Full
Operations or Marketing menus

Shared Account

& Standard User account that will be
shared by multiple users such as a
conference room computer, Users will
select a contact profile at login.

Delete Cancel

ﬂ L

Each user of Advantage
must be entered as a
Contact in the Advantage
database marked as an
employee of the firm. If
the employee is already in
the database, select the
employee’s name from the
list in the Select an
Employee field. If the
employee’s name is not in
the dropdown list of
Employees, enter the
employee’s first and last
name in the Enter a new
Employee field. The
employee will be added as
a contact in the database
and marked as an

employee.

The Windows Login Name field will be pre-filled with the user name used to log into this

computer.

Each user of a Windows computer has a Login Name. If your firm has a Local Area Network (LAN),
this Login Name is the name that a user enters whenever he or she logs in to the LAN. Even if your
firm doesn't have a LAN, each computer has a User Name associated with each user account set up

on the computer.

On a Windows XP computer, the Login Name of the computer's current user appears at the top of
the Start Menu when the Window's Start button is clicked. It is this Login Name that must be

associated with the corresponding user's employee record in Advantage.

If you are the Advantage Administrator, use this screen to associate an employee’s Login Name with
his or her employee record in Advantage. If the user may log into any computer where Advantage is
installed, select Any Computer. If he or she will be accessing Advantage only from this computer,
select This computer ONLY. In general it is best to select the default option of "Any Computer.”
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Select the user’s role from the options presented and select Save to add the user to the database.
Click Save and Add Another to add additional users. If additional users are added from the same
computer, make sure that Windows User Name field is changed to reflect the Windows user name
of each user being added. To avoid confusion, it is easiest to simply add each user from the
computer which that user will use to access ProTracker Advantage, after Advantage is installed on

their computer.

For more information, press F1 from the Add a User dialog, and read the Help file that corresponds
to the Add a User dialog.
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Office Setup

Offices

(Search) w

Offices Company Name  [Sample Firm

- Assistant -
Short Marme |Main | Primary Office

Add an Office
Delete this Office

Office Address

m—  Address

= City, State Zip w
Cffice Mame* | | ’ | |—| |
Shart Name* | | Office Communications
Descripkion
Fhone 603-026-1775 TolFree [ ]
Fax 603-526- 1243
‘Web Page vy, sample,com |
E-Mail info@sample.com |
Save and Close ] I Cancel ]
Address i
City, State Zip v [
Label Address
- Recent - |E|
F=| Adminstrator, Robert Address
B sl City, State Zi M 11
; - ity, State Zip v
Achilles, Martin
%‘ e 2 Fhone 603-926-1775
b asal Fax Fiv 603-926-1249
=] Bosen, John K.

1. Open the Operations menu and select Offices.

2. On the Offices screen, go to the Assistant area in the left frame and double-click on Add an
Office.

3. On the Add an Office dialog, enter the Office Name. This should be the full office name as
it will be printed on correspondence.

Enter a Short Name for the office. The Short Name is an abbreviated office name used to
identify the office within ProTracker Advantage.

If desired for clarification, enter a short Description of the office.
Click the Save and Close button.

4. On the Offices screen, check the Primary Office checkbox (upper-right corner) to
designate this office as your primary location.

5. Enter the Office Address and Office Communications information.

6. To print your return address on envelopes, enter the Envelope Address for this office.
If your return envelopes are preprinted with your address, leave the Envelope Address
fields blank.

7. To print your return address on shipping labels, enter the Label Address information.

If your shipping labels for this Office are preprinted with your return address, leave the
Label Address fields blank.
8. To add another Office location return to Step 2.
-6-
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Adding Employees

1.

8.

9.

Open the Operations menu and select Employees. Note that you will only need to use
this screen to add employees who are NOT users of ProTracker Advantage, since users that
were added from the Add a User screen are already listed as employees. All Users of
ProTracker are considered to be employees of the Office, but all employees may not be
ProTracker Users.

On the Employees screen, go to the Assistant area in the left frame and double-click on
Add an Employee.

7 3. On the Add an Employee dialog,
=1 Add an Employee E' enter the Full Name of the
- employee. This should be entered
Full Mame . -
s as Salutation, First Name,
Cantact Type® = Middle Name or Middle Initial,
Ofiice® e = Last Name and Suffix. Note that
: the asterisk (*) following Windows
Emplover | User Name indicates that this is a
Profession ot required field. This convention is
Pasition ¥ used throughout Advantage
Date of Hire

screens to denote required fields.

Business Email

B b 4. The File As name is an index field

and automatically defaults to Last
Name, Suffix, First Name,
2ave | | el Middle Name or Middle Initial.

5. Select a Contact Type of
Employee from the pick list.

Select the Office where this employee primarily works.

In the Employer field, select your company name. If your company is not on the list, click
Cancel to exit this screen and perform the Office Setup steps on the prior page before
adding employees.

Select the employee’s Profession, Position, and enter the Date of Hire.

Enter their Business Email and Business Phone number.

10. Click the Save button to add the employee to the list.

11.To add the next employee, return to Step 2.

12.To edit employee information, double-click a person in the Employee list.
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Setting up Firm-wide Document Management

If you wish to utilize Advantage’s document management system, you will need to assign folders
that will be used to store contact, client, and group documents.

Client, Contact and Group Documents:

If you are using Advantage in a multi-user environment, create these folders on a shared drive
or server. If your server is mapped to drive letter S:\, for example, use Windows Explorer or My
Computer to create folders to store client, contact and group documents. The following folders
locations are suggested:

S:\Clients

S:\Contacts

S:\Groups
If you are using Advantage in a single-user environment, create folders to store client, contact
and group documents using Windows Explorer or My Computer. The following folders locations
are suggested:

C:\Program Files\ProTracker Advantage\Documents\Clients

C:\Program Files\ProTracker Advantage\Documents\Contacts

C:\Program Files\ProTracker Advantage\Documents\Groups
Photos: Advantage allows you to link digital photos of your clients and contacts to their profile
records. Linked photos will be stored in the folder you designate. For this purpose, we
recommend that you create folder S:\Photos for multi-user systems, assuming that S: is your

shared folder’s drive letter or folder C:\Program Files\ProTracker Advantage\Photos for
stand-alone systems.

Now open the
Application Preferences I Custom Fields I Suppressed Ikems _ OPerations Menu in

Documents &FPhotos || Reports || Misc | ProTracker Advantage
N | | ond select Database

Path ko Client Docurments |S:'|,Clients |[ Browse ] Administration.

Path ko Contack Documents |S:'|,C0ntacts |[ Browse ] .

Path ko Group Documents |S:'|,'|,Gr0u|:|s'|, |[ Browse ] Click the Browse

Mew Folder Template |Initia|'l,Fi|eF\s v ?Lll(tjton to select thde

Create Folders when merging ta word aOS tE;S Pyaotll:l] igegltleent,

Default scanner file format  |PDF " ContaCt, and Group
documents.

ey ]

Path to Fhotos 5:\Phatos) [ Browse ] If you have pre-
existing document
folders for clients,
you may wish to
move documents
from those folders to
the new Path to
Client Documents
or you may select the
pre-existing path as
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the Path to Client Documents instead of the newly created Clients folder.

New Folder Template

Once selected, the Folder Template option should not be changed. Your selection tells ProTracker
how to create sub-folders beneath the Client, Contact and Group folders selected. There are eight
options. For most situations, choice 1 or 2 is recommended:

1.

PN W

Initial\FileAs - All documents for a given Client, JICI_,ITT
Contact, or Group will be stored in a folder whose name £ ) B
is the first initial of the object's FileAs, and within the 1D
initial folder, in a sub-folder whose name is is the same
as the object's FileAs name. This is a logical choice for a ) Carmant
large firm that has over 50 clients. Note the example on = [ Casstine
the right. 3 Biling
) Cash Flow
) Correspondence
) Estate Planning
) Financial Planning
) Insurance
= |2 Clignt I Investments
) Aarons ) Retirement
) Adams ) Taxes
) Baker 3 Callins
) Caffrey D
) Carmant
= |} Casstine
) Billing 2. FileAs - All documents for a given Client, Contact, or
=) Cash Flow Group will be stored in a folder whose name is the object's

) Correspondence
) Estate Planning
) Financial Planning
) Insurance
) Investments
I3 Retirement
) Taxes

) Colins

) Dallas

FileAs name. This is a logical choice for a smaller firm of 50
or fewer clients. Note the example on the left.

Initial\LastName - This option is identical to Initial\FileAs, except the Contact or Client's
Last Name is used in place of the File As field. In most cases, the FileAs field is the same as

the Last Name.

LastName - This option is identical to FileAs, except the Contact or Client's Last Name is
used in place of the File As field.

Office\Initial\FileAs
Office\FileAs

Office\Initial\LastName

Office\LastName
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Note:

® Options 5-8 are identical to options 1-4, with the extra dimension of being intended for multi-
firm offices or multi-office firms where it is necessary to store Contact, Client and/or Group
documents separated by firm or office.

® Options 3 and 4, 7 and 8 should be used with caution. If documents are being filed for more
than one Client or Contact with the same last name, they will all be in the same Client or
Contact folder.

Photos
Click the Browse button to select the Photos folder.

For more information on setting up Document and Photo Paths, open the Operations Menu and
select Database Administration. Press F1 from the Application Preferences tab in ProTracker
Advantage to open Help and display and article that explains all fields on this screen.

Setting Up Merge to Word Template Storage

If you plan to utilize ProTracker Advantage’s Merge to Word mail merge features, use Windows
Explorer or My Computer now to create a folder for storage of Microsoft Word templates.

Advantage’s Merge to Word feature may be accessed from many

screens in Advantage. In order to ensure that templates you create =D Templates
from each location are easily found, and to allow users in the firm to (D Address
share templates, use Windows Explorer or My Computer to create L) Asset
folder S:\Templates for multi-user systems, assuming that S: is I Client
your shared folder’s drive letter, or folder C:\Program I Contact
Files\ProTracker Advantage\Templates for stand-alone IJ) Estate
systems. Also, create separate sub-folders beneath the Templates I Group
folder as depicted to store templates used in each area. I Insurance

|3 Marketing
Search for "Merge to Word” on the Index tab in Advantage Help for ) Nate
more information on storing and using templates. ) Performance Reports

I Task

| Tax
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Configuring Printers

To configure your printer settings in ProTracker Advantage, open the Tools menu and select Printer
Setup.

1 Printer Setup F$?|

Select a Printer for each Report Type.

Partraik hp Laserdet 3015 PCL & " | [ ]
Landscape :hp Laserlet 3015 PCL & " | [ ]
Envelopes :hp Laserlet 3015 PCL A w | [ ]
Small Labels Ihp Laserlet 3015 PCL & P I ]
Large Labels Ihp Laserlet 3015 PCL & v l [ ]
Shest Labels Ihp LaserJet 3015 PCL & W l [ N ]
Badges Ihp Laserlet 3015 PCL & v! [ ]
PDF [PraTrackerPDF el l

|
Print in safe mode with defaulk settings F

k. | | Cancel |

Select a printer for each type of Advantage report and click D (the Browse button) to set
margins and other settings.

Use the recommended settings for each report type from the Help screen (accessed by pressing the
F1 key).

Note: Before you may select ProTrackerPDF as the “printer” for PDF files, you must install
ProTracker’s PDF writer. Click the Home button on the toolbar, select the Options tab, and double-
click Install ProTrackerPDF in the Assistant area on the left of the screen.
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Getting Started Tutorial

Introduction to ProTracker Advantage
Every ProTracker Advantage screen consists of the following 7 areas:

) ProTracker Advantage 4.0 - [Sample Firm]

Menu » ﬂ File Edit View Operations Marketing Regulatory Tools Help

Toolbar > ﬁ Home @ﬂav |E| Contacts ~ Q Clients ~ @ Groups * | E Calendar = & Tasks = J" Motes = | ] Documents ~ iﬂ Reports ~ ) Back !

Home Recent Activity Document Review
Search Box p |5 I I
- Assistant - Appointments For Warren (4) Apr 25, 2005 to May 01, 2005  =RUEEq + |Open ~ N[
:gj = E“e’gd Date Time Related To Appointment |
. a Con : : : z 7 S = T
Assistant } Add & Note Wed, Apr 27 400p -5:00p =] Achilles, Martin Initial Meeting: Focus on retirement planning issues
Add a Static Group Fri, Apr 29 9:00a - 10:00a Q Sample, John & Mary Discuss Cash Flow Statement issues,
Add a Task Fri, Apr 29 12:00p - 1:00p Q Coors & Knotts Meet to review retirement projections
Add an Appointment Sat, Apr 30 12:00p - 1:00p EE] Shaw, Maurice F. Discuss Kevin's applications for accounts. Mike indicated b...
Email
New Contact Wizard
Reports »
ii Calendar
iﬂ Employee Schedule
il Tasks # Tasks For Warren (3) Apr 01, 2005 to Apr 30,2005 (LG + |Open + (bl
[A| | Related To Task ] Due Date
O E=l ambrosi, Donahue &Co ¥ Call this afternoon about... ! 04/12/2005
O E=l Maddox, Linda A. Screen new inquiry through return telephone call, 044282005
O E= Kattar, Karen A, 1 Screen new inguiry through return telephone call. Karen is interest. .. 044292005
Recent »
i Newsletter
9 colingford k
Q Laughlin
=] Sample Ir., John A. Double-dlick to edit a task.
Q Sample, John & Mary
A Work Area A
Menu

ﬂl File Edit ‘iew Operations Marketing Regulatory Tools  Help

Use the Menu to perform various Advantage commands. The Menu selections are File, Edit, View,
Operations, Marketing, Regulatory, Tools, and Help.

Toolbar
ﬁHDme éa Mav =] Cortacts = © Clients = @ Groups * [3] Calendar - & Tasks~ J Motes | ] Documents + 5] Reports ) Back!

The Toolbar buttons are used to jump easily to various Advantage topics found under the Menu’s
View command: Home, Contacts, Clients, Groups, the Advantage Calendar, Tasks, Notes,
Documents, and Reports.

Click the Nav button to search for Contacts, Clients, and Groups.

Click the Back button to return to a previous topic.
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Search

Mackensen -

The Search Box helps you to find Contacts, Clients, Groups, and Assets. Enter any three consecutive
characters or more of a name, telephone number, ZIP code, or account number to view a list of
entries that match your search. Many fields are searchable, such as email addresses, social security
numbers, keywords, and employers. See the Help article under Search -> Search Options for
more information.

If only one match is found, Advantage opens the Contact’s Profile or Account Detail.

Assistant
- Assistant -

| Add an Appainbrnent |

: fdd a Task, h

Add a Maoke

The Assistant is a list of commands located below the Search box and includes frequently-used
actions for the current screen. For example to schedule an appointment, double-click the Add an
Appointment Assistant command.

Net ‘arth L |
Prafile

Double-click one of the listed Reports to preview and print information pertaining to the current
screen.

Click (the Minimize button) to hide the Reports list. When the Reports list is hidden, click D
(the Maximize button) to display it again. Minimizing the Reports list may be needed if more
Assistant commands are available than will fit in the Assistant box.

Recent

- Recent - |E|

The Recent area lists Contacts, Clients, and Groups that you have most-recently opened. Double-
click a name to open their Profile.

Click (the Minimize button) to hide the Recent list. When the Recent list is hidden, click D (the
Maximize button) to display it again. Minimizing the Recent list may be needed if more Reports are
available than will fit in the Assistant box. You may also want to minimize the Recent list when using
Advantage to assure client privacy during meetings.

Work Area
The Work Area is where Advantage screens are displayed.
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The Help System

You can start the built-in Help System by opening the Help menu and selecting ProTracker
Advantage Help, or by pressing the F1 key at any time to view Help for the current screen.

Contents tab

The Contents tab iS the E? ProTracker, Advantage Help

Table of Contents for the G D

Advantage Help System. Hide  Back Fomward  Print _
Browse Help topics by °“‘e““l'ndex | search| a

& Welcome to ProTracker Advantage
s \v\u"ha.l's New? ) advantage
& Getting and Using Help
2 Installstion

@ biriage Baser
& Getting Started
& Home & Goal is a Client aim with a specific Objective (a Target Date and cash
@ Contacts Amount),

@ Clients
& Groups To add a goal, open the Client's Life Planning tab and click the Add
& Calendar button on the Goals tab.

& Tasks
R Motes
R i
& Operations
e Communications ol ‘Buy car v |
@ Marketing Objective Accumulate $35,000 by August 2005
i Regulatory

double-clicking a book to
view a list of subtopics.

Index tab

Use the Index tab to
search for keywords in the
Help text.

Search tab

If you cannot find what you
want using the Index, try
entering specific words on
the Search tab. All Help
files that contain the string
you entered will be found,
and the string will be

Target Date 08/01/2005 Amount $35,000,00
Weight 25.00 % Complete 15.00

[§ave and Close ] [ Save and Add Another ] [ Cancel ]

highlighted in each file. Iy
e

Hide | and _shew | puttons
Click the Hide button to view Help without the Contents, Index, and Search tabs. When the tabs
are hidden, a Show button replaces the Hide button. Click Show to view the tabs again.

<=

Back | button
Click the Back button to return to the previous Help topic.

=

Forward button
After you have clicked the Back button, you can click the Forward button to return to the next Help
topic.

=

Frint | button
Click the Print button to print the selected topic only, or to print the selected topic and all subtopics.
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The Home Screen
The Home screen displays your scheduled appointments and assigned tasks.

F1 ProTracker Advantage 4.0 - [Sample Firm]

@l Fle Edit View Operations Marketing Reguatory Tools Help
ﬁ Home Q}ﬂav |E| Contacts = Q Clients = @ Groups = | E Calendar ~ & Tasks ~ ) Motes = | ] Documents ~ ii Reports = ¥) Back

Document Review

Apr 25, 2005 to May 01, 2005 This Week

Appointment

Initial Meeting: Focus on retirement planning issues

Discuss Cash Flow Statement issues,

Meet to review retirement projections

Discuss Kevin's applications for accounts. Mike indicated b...

Appointments For Warren (4) + [0pen

- El
Add a Client

Add a Contact

Add a Mote

Add a Static Group
Add a Task

Add an Appointment
Email

Mew Contact Wizard

Related To
E=] achilles, Martin
9:003 - 10:003 Q Sample, John & Mary
12:00p- 1:00p 8 Coors &Knotts
12:00p - 1:00p EE] shaw, Maurice F,

Date

Wed, Apr 27
Fri, Apr 29
Fri, Apr 29
Sat, Apr 30

Time
4:00p - 5:00p

ﬂ_i Calendar
ﬂ Employee Schedule
iﬂ Tasks

This Manth

v [[=]H

& Tasks For Warren (3)

[A| | Related To

Apr 01, 2005 to Apr 30, 2005 » 10pen

Task Due Date

O E= ambrosi, Donahue & Co
O E=l Maddox, Linda A.
D B Kattar, Karen A.

! call this afternoon about...
Screen new inguiry through return telephone call,
L Screen new inguiry through return telephone call. Karen is interest. ..

! D4f12/2005
04/28/2005
04/25/2005

X

Double-dick to edit a task.

P=| sample Ir., John A,
2 Sample, John & Mary

The Appointments panel lists all your appointments that are scheduled within the selected date
range. Use the filters in the title bar to specify the date range for the listed appointments or to limit
viewing to only upcoming appointments (Open), only previous appointments (Closed), or all
appointments (Both).

¢ Double-click an appointment to see details.

e To schedule an appointment, click (the Add button) in the upper-right corner of the
Appointments panel or double-click the Add an Appointment Assistant command.

The Tasks panel includes tasks that have been assigned to you. Use the filters in the title bar to
specify the date range for the tasks you want to see, or to list only the Open tasks, only the Closed
tasks, or all Open and Closed tasks (Both). You also have the choice of Open (hide overdue) which
will hide all past due tasks which are still marked as Open.

e Double-click a task to edit the task.

e To create a new task, click (the Add button) in the upper-right corner of the Task panel
or double-click the Add a Task Assistant command.
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Add a Contact

Every person associated with your practice should be entered as a Contact once and only once. This
includes, but is not limited to, employees of your company, prospective clients, existing clients,
relatives of clients, beneficiaries of clients, attorneys, CPAs, etc. After a Contact is added, it can be
designated as a Client, included in a Group, assigned as a beneficiary, or selected wherever a
dropdown list of contacts is provided for selection.

Note: Again, every person, business or trust should have only ONE Contact record in Advantage. If
an employee is also a client, for example, and the person has already been added to the database as
a ProTracker Advantage User (see Adding Users on Page 4) or as an Employee (see Adding
Employees on Page 7), then don’t add them again as a Client.

Add a new Contact to the Contact List by double-clicking the Add a Contact Assistant command, or
by clicking the Contacts toolbar button and selecting Add a Contact. The Add a Contact dialog
opens.

Fz] Add a Contact [X]
B=] Full Mame* |Carol Shepherd | BusinessorTrust [] SSN [#59-33-5593 |
Salutation  |Ms Add to Groups
Gender F o DiDE 057301942
F_s 05/30/1942 | =

frm OO v
OFFice™® Main “ »
Firmn Conkack®  \adminstrator, Robert “ »
Contack Type*  |Prospeck W »
Source Date 041372005 Emplover “
Referred By Asppel, Jackie “ Profession “
Source Type  |Client Referral w Pasition w
address 1 702 Fairview Lane Phone
Address 2 Fax
City, State Zip |Paink Pleasant w |y |/10058 Email
Counkry Cell
Address 1 Phone
Address 2 Fax
City, State Zip w| | Email
Counkry Cell

[ Save and Close ] [ Save and Go To Profile ] [ Cancel l

Note that the asterisk after the field description indicates that entry is required.
¢ In the Full Name field, enter the Contact's first name, middle name or initial (optional), last

name, and suffix. If the Contact is a business or a trust, rather than a person, enter the
complete business name in the Full Name field and check the Business or Trust box.
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e Select the Office that will be responsible for the new Contact, if the firm has more than one
office.

e Select a Firm Contact - the employee who will be responsible for the new Contact.

e Assign a Contact Type. The Contact Type for a new Contact is usually one of the
following:

Prospect
Prospects are prospective Clients.

Client
A Contact who has signed an agreement with your company and who will be billed for

your services should be assigned a Contact Type of Client.

Contact
Assign a Contact Type of Contact to any professional with whom you may work on
Client situations, such as attorneys, accountants, and insurance agents.

Vendor
Anyone that sells your company products or services should be entered as a Vendor.

This includes repair companies, utilities, office products suppliers, and your computer
consultant.

For more information on the definitions of fields on this screen, select F1 when the Add a Contact
screen is displayed.

Click the Save and Go To Profile button to add the new Contact and begin entering additional
information about the Contact on the Contact profile screen. Just click Save and Close to continue.
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Add a Client

Add a new Client to the Client List by double-clicking the Add a Client Assistant command, or by
clicking the Clients toolbar button and selecting Add a Client. The Add a Client dialog opens.

Fz] Add a Client

© Client File 8s*  [Shepherd | Married []

B=] Primary Contack* |S|'u3|:||'|er|:|J Caral L.
B=| Second Contact | w |[.ﬁ.u:||:|]

Add to Groups Mo Expiration

Preferences

AR

Salutation Ms
Mame(s) on Envelope (Caral L, Shepherd

Preferred Camm w | Contact Individually? []

Remove individual contacts from these groups?

Office® Mair +| (O cComplimentary ~

Firm Contact®  |[Adminstrator, Robert +« || O <ontract

Client Type w | Primary Clienk? O Financial Flanning )

Client Since®  |04/16/2005 | Client I | O Hourly

Priority v [ 1nitial Financial Planning

Skatus Active b O Investment Management -
bing |

Accounting ID | Bil Client directly?  [] O adminstrator, Robert ”~

Rate | O Investor, Kewin

Billing Frequency v | O mMackensen, Watren J. E|

Billing Cycle + | |O operations, smanda

Biling Address |02 Fairview Lane Point Pleasant, MY 10056 « || |[]  Planner, Patricia "

Save and Go To Prafie

Save and Close |

Cancel

e Use the Client File As field to identify the client on lists and reports. Enter a short name
that will allow you to easily identify this client. By default, Advantage will use the client's

last name, but you may change this to suit your needs or distinguish between clients with
the same surname.

¢ Select the Primary Contact for the Client. If the name of the Contact is not listed, click
the Add button to open the Add a Contact dialog.

e If the Client is comprised of more than one contact (for example, a married couple),
select the Secondary Contact for the Client. If the name of the Contact is not listed,
click the Add button to open the Add a Contact dialog

¢ Select the Office where the Firm Contact works.
¢ Select a Firm Contact - the employee who will be responsible for the new Client.

e Client Since automatically displays today’s date but may be changed if desired.

These are the only fields required to add a new Client. Click the Save and Go To Profile button to
add the new Client, close the Add a Client dialog, and open the new Contact’s Profile screen to begin

-18-

ProTracker Advantage Getting Started Guide Microsoft SQL Version



entering additional information. Select F1 when the Add a Client screen is displayed for more

information on the information requested.

Schedule an Appointment

To schedule an appointment, double-click the Add an Appointment Assistant command, or click
the Calendar toolbar button and select Add an Appointment.

The Add an Appointment dialog will open.

Fz]1 Add an Appointment

Related To* | € sampls

Beqin Date®  [01712)2005 All Day Event?r []

Start Time*  |2:00p
ot of Cffice? []

=

* | End Time* |3:00p w

Appointment Date

Appointment Details

Cakeqgory Meeting in Office
Tvpe Client Meeting
Location

Pipeline Event
Rewview Evenk

w
w
Conference Room #2 L
w
w

Performance Report With Client

Reminder? Time Before Event |1EI ity R | Private? |:| Include on Meeting Agenda? |:|
Appointment Description® Attendees
Annual Meeting w || Add
5= Mackensen, Warren 1.
5=] sample Jr., John &,
5=] Sample, Patricia H.
assigned To* Mackensen, Warren J. v |

Criginator |C-3|rr||:||:uEEIIJ Fonald T.

Origination Date  |12/14/2004

Date Closed

|

|This Appoinkment recurs,

| Save and Close | | Print Preview | |

Ermail

| | Delete | | Cancel |

e Assign the appointment to a Contact, Client, or Group by selecting them from the Related To

list.

e Enter a Begin Date, Start Time, and an End Time.

e Enter an Appointment Description.

e Verify that the Assigned To is correct.

These are the only fields needed to add an appointment. Click the Save and Close button to add
the appointment to the Advantage Calendar and exit the Add an Appointment dialog.

For information on any of the other fields, read Advantage Help for the Appointment Dialog,
available by pressing F1 when the Add an Appointment dialog is displayed.
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Add a Note

To create a note, double-click the Add a Note Assistant command, or click the Notes toolbar button
and select Add a Note. The Add a Note dialog will open.

Fz] Add a Note %
Related To*
| E Shepherd ‘j Opened Efiﬁ_ﬂ% Closed
Category™® | s =g tplgTgn] b | Include on Meeting Agenda [ Include on Financial Plan ]

Save and Close
Save and Add Another
Go ko Profile
Brink Presview
Merno
Merge ko WWord
Emnail
Delete

Cancel

Originator |.Cl.|:|minstrat0rJ Roberk

e Click the Related To dropdown list to select the Contact, Client, or Group to whom the note
refers. If a Client or Contact is active when Add a Note is selected, that person will already
be selected.

e Assign a note Category.

e Type your note in the Note field.

e The Opened field defaults to the current date but may be changed if desired.

Click the Save and Close button to add the note and close the Add a Note dialog.

For other fields, please read Advantage Help for the Note Dialog, available by pressing F1 when the
Add a Note dialog is displayed.
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Assign a Task

To assign a task, double-click the Add a Task Assistant command, or click the Tasks toolbar button
and select Add a Task. The Add a Task dialog will open.

2] Add a Task

L]
%)

Related To* ] Q sample | Action Person*  |\Adminstrator, Robert v|
Due Date* 07/19/2005
Category [Estate Planning v| Priarity s

Include on Meeting Agenda [ Incude on Financial Plan 7] Assigned By Adminstrator, Robert

Include on Report Card [] Include on Client Task List  [7] Crigination Date  (07(18/2005 Private? ]
PN
w

Save and Close
Discuss new retivement plan limits for next year before open enrollment season this Fall,

Save and Add Another
G0 ko Profile

Prink Preview

Task Results Memo

Email

Merge to Word

Delete

Reminder Date | | Time | w | Est Hrs Est Fee Cancel
Matify Sction Person immediately with a popup? E Shatus | Progress 0% b5
Motify Action Person by Email when task is created? L Completion
Matify Originatar by Email when task is complete? L
Task Complete? Completed
Recurrence Actual Hrs Actual Fee

[inane} |E]

e C(Click the Related To list to select the Contact, Client, or Group to whom the task refers.
e Assign a Category to the task.
e Enter a description in the Task field.

e Select an Action Person - the Contact who will be primarily responsible for completion of
the task.

¢ Enter the date when the task needs to be completed in the Due Date field.

These are the only fields necessary to add a task. Click the Save and Close button to add the task
and close the Add a Task dialog.

For other fields, please read Advantage Help for the Task Dialog, available by pressing F1 when the
Add a Task dialog is displayed.
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Add a Group

There are two types of Advantage Groups: Static Groups and Dynamic Groups.

A Static Group is a combination of Contacts that are treated as a single entity. For example, a Group
might be all of the members of a family or an association to which you belong.

Add a new Static Group to the Group List by double-clicking the Add a Static Group Assistant
command, or by clicking the Group toolbar button and selecting Add a Static Group. The Add a
Static Group dialog opens.

F] Add a Static Group F§|

@ aroup Mame*  |Gold Clients

Group Type*  |Conkack Group L
Touch Option  []

Descripkion Annual bilings between 45,000 and $9,999,

Save and Edit Membership | | Save and Close | | Cancel

e Enter the Group Name as you would like it to appear on search lists and reports.
e Select a Group Type from the list. There are four Group populations:
Any: any Contact, Client, or Employee can be added to the Group.
Contact Group: only Contacts can be added as a member of the Group.
Client Group: only Clients can be added to the Group.

Employee Group: only Contacts with a Contact Type of Employee or
Employee/Client can be added as a member.

e C(Clients and Contacts need periodic “touches” during the year to maintain relationships.
Check the Touch Option checkbox if the Group should appear as a Touch Option on the
Contact Profile screen. Examples of “touches” are: birthday cards, anniversary cards,
holiday cards, Form ADV offers, and privacy notices.

Click the Save and Edit Membership button to add the new Group, close the Add a Static Group
dialog, and begin adding Contacts, Clients, or Employees to the Group.

For more information on Static Groups and Dynamic Groups, open the Help Menu, select ProTracker
Advantage Help, click the Index tab, and enter “"Groups.”

-22-

ProTracker Advantage Getting Started Guide Microsoft SQL Version



Backing up your data

ProTracker Advantage is an enterprise-wide data storage system. Once the system is in operation in
your practice, your data becomes mission critical. If lightning strikes your office, your active
database may become hopelessly corrupted. If your office burns to the ground overnight or vandals
steal your computers, all of your Contact records are gone. For these reasons and more, make it a
habit to create a backup copy of your database every day and store it off-site every day.

For more information on backing up your database, click the Help Menu and select ProTracker
Advantage Help. Enter the key words Backup Database.

Maintaining your database
The SQL Server version of Advantage does not require regular database maintenance.

If you are using the Microsoft Access version of ProTracker Advantage, an Advantage user with
administrator privileges should make it a habit to run File > Database Maintenance weekly when
all other users have closed Advantage.

For more information on maintaining your database, click the Help Menu and select ProTracker
Advantage Help. Enter the key words Database Maintenance.

ProTracker Support Procedures

ProTracker Software is committed to providing you with the best possible customer support. These
guidelines list your available support resources.

Built-in Help

The best source of information for ProTracker Advantage is the Help system. Through the Help
system, product information is available instantly, 24/7. Use the Help file for answers to common
questions about program usage or to learn more about the current screen.

How to use Help

Click the Help menu and select ProTracker Advantage Help, or press F1 to open a Help article
relevant to the current screen.

For quick answers to common questions, search Help's Index tab for keyword FAQ. For the big
picture on a topic, search the Help Index for keyword Overview.

Use the Search tab to find topics containing specific words. More on the Help system is found and

page 14 of this guide.

Online Tutorials
Use online tutorials to learn how to perform common tasks or to help train new users.

How to use the online tutorials
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Visit http://www.protracker.com/Training/ to view online tutorials or to schedule a live training
session.
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Knowledge Base
Use the Knowledge Base for configuration information or to find solutions to technical problems.
How to use the Knowledge Base

Visit http://www.protracker.com/Support/ to view online support options. Click the Knowledge
Base link to search for specific articles.

Customer Support by Email

Customer support by email is available from 9 am to 5 pm ET Monday through Friday. Generally,
emailed inquiries receive a response within 4 working hours. Please be aware that during times of
heavy volume, this initial response may be delayed. To ensure a prompt response, submit your
inquiry only once and include as much detail about your question or problem as possible.

When to use Email Support

Contact support by email with questions or comments that don’t require an immediate response or
to request new features. This will allow us time to research your question thoroughly and provide an
accurate and timely response.

How to use Email Support

To ask a general question about the program: Click the Help menu and select Contact Customer
Support. We prefer to receive questions by email using this menu option for the following reasons:

1. The email will include an attached report that tells us your current version number and
configuration.

2. Written requests allow us time to research the problem and recommend appropriate steps.

3. Operational questions can often be answered by helping you find the appropriate Help
article, or links to the appropriate recorded tutorials.

4., Common questions can quickly be answered.

5. Answers that require lengthy telephone conversations can be scheduled at a time
convenient for both of us.

To report a problem: Click the Help menu and select Contact Customer Support. When reporting
a problem, please include as much detail about the problem as possible. The better your description,
the quicker we can assist you.

® Describe the steps you took that resulted in unexpected behavior.
e Tell us what you expected to see.
® Tell us what you saw instead.

® Include screen captures or other graphics as appropriate and the exact text of any error
messages if any are displayed.

o Tell us how long the problem has existed and whether there have been any recent
changes to the hardware, software, or settings on the affected computer.

_25-

ProTracker Advantage Getting Started Guide Microsoft SQL Version



To request a new feature: Click the Help menu and select Submit an Enhancement Request. We
recommend that requests for new features be submitted in writing to avoid ambiguity.

® Describe the particular feature(s) you'd like to see.
e Include screen captures or other graphics that illustrate the suggestion, as appropriate.

e Explain why you think your feature request will be useful to you and other users.

Customer Support by Phone

Please call us if the resources above do not solve your problem, or your question requires an
immediate response. Customer support by phone is available from 9 am to 5 pm ET Monday through
Friday at 603-926-8085. Every phone call is nearly always greeted by a human voice. During times
of heavy volume, your call may go to voicemail. Please be patient, we will get back to you as soon
as possible.

When to call Support

Call support if your problem or question requires an immediate response, such as loss of database
connectivity, or an expired license key.

How to call Support

When requesting support by phone, please call from the computer experiencing the problem and be
prepared to assist customer support staff in troubleshooting your issue.

Support for non-ProTracker related software or hardware

For help with error messages, system performance, non-ProTracker hardware and software issues,
especially printers, networks, and system security, click the ProTracker Help menu and select
Knowledge Base. If you cannot find the answers in our Knowledge Base, we recommend
contacting the manufacturer of the non-ProTracker hardware or software for the fastest and most
accurate answers to your questions.
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